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Copyright statement
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! �The information contained in this documentation is subject to change without notice. The program 
described in this document is provided under a license agreement and may be used only in accor-
dance with the terms of that agreement. This manual may not be copied in any form for any purpose 
other than the purchaser‘s personal use.

! �The features described in this documentation are subject to change without notice.

! �If you notice an inaccuracy in this documentation, please report it to info@klarso.com so that we can 
correct it.
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User’s guide
A high-quality index provides readers with a quick way of finding content. For digital publications, 
readers need precisely linked indexes to find the text passages they are looking for. This is true even on 
small devices. Embedded index entries can also serve as the basis for generating metadata for keyword 
or semantic searches.

Creating an index can, however, be a source of seemingly endless frustration for the author, indexer, or 
editor, or whoever is involved. The fragmented nature of the production process also results in a high 
number of mistakes. Typographical errors, incorrect classifications, and false page number ‘hits’ are 
common errors in indexes. Embedding and generating an index via built-in functions, such as those 
of Adobe InDesign or Microsoft Word, can be laborious and time-consuming. Index-Manager provides 
professional indexing features which facilitate the indexing work, and it embeds index entries into 
original documents.

Index-Manager is the product of an interdisciplinary team of editors, indexers, and IT specialists at 
Klarso GmbH in Berlin, Germany.

At this point, many thanks to all indexers whose feature requests improve the software successive, 
and who make Index-Manager known with their articles, posts and presentations. Special thanks to 
Pilar Wyman and Kate McIntosh for their great help on the manual. Pilar completely revised the text 
in several cycles in terms of content and language and Kate created the detailed and well-thought-out 
index – of course in Index-Manager. 

This manual contains a step-by-step guide for practical work with Index-Manager. It describes the ge-
neral properties and major features of the software and takes you through the whole indexing process. 
The functions described in the documentation are organized according to the menus in which they 
appear.

1.	 General properties and step-by-step guide
Index-Manager can import any number of documents in the XML-based formats of Adobe InDesign 
(.idml), Microsoft Word (.docx, docm), DocBook or XML (.xml, after individual configuration to the used 
DTD). Index-Manager imports the XML data of a document and offers it for viewing via an HTML sty-
lesheet. 

After import, index entries can be created and edited in the document view. The user can index by 
marking keywords (extraction indexing) directly in the text view as well as by manually entering terms 
(assignment indexing). The growing index is displayed in parallel in a live preview. Indexing work can 
be facilitated with numerous analysis and edit functions such as term selection, for correction, and 
quality check. 

Finally, the index entries are embedded into the source documents via Export, which is when the XML 
data of the imported Word or InDesign document is updated with the index information. After Export, 
the document will contain all the index entries created with Index-Manager in the program’s own 
fields. Also after Export, the index can be worked on as usual via the functions provided by Word or 
InDesign. 
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1.1	 Work files
While working with Index-Manager, the source document is not changed. 

Instead, indexing information is recorded into work files that are generated during the import as .idx 
files. These .idx files are stored in the same folder as the source documents. One .idx work file is created 
for each imported document. 

!! Note: Work files can be opened in standard Windows text editors such as Notepad++ (or TextEdit or 
Coteditor in MacOS). This is normally not necessary, however. In the .idx work files, each index entry is 
logged with its exact position: the section number, the number of words it is from the beginning of the 
section to its entry anchor position, and two adjacent words.

The instructions in the work files are carried out and implemented in the imported source documents 
only when the project is exported. 

1.2	 Saving in Index-Manager
!! Note: Saving in Index-Manager is not necessary. Each step is automatically logged in .idx files

Every index alteration is automatically logged into separate .idx work files. It is not necessary to save 
work in Index-Manager. 

If you are working on a large project and have created a lot of index entries, Index Manager will have 
to log and carry out a long list of instructions and change history. You can avoid long load times by 
exporting your data regularly.

1.3	 The work files have several advantages
With .idx work files, index entries can be embedded at any time, even into changed or edited versions 
of source files. (Replace source documents). Tasks such as copyediting can be done in parallel to in-
dexing. Indexing is no longer a time-critical or stressful last-minute task. 

Normally, to embed index entries, original documents must be sent to the indexers, and with more 
complex InDesign projects, incompatibilities between different InDesign publisher/indexer versions 
lead to layout problems. When index information is exchanged via .idx work files, however, data sover-
eignty remains with publishers. 

When producing new editions, .idx work files can be used to transfer index entries from older editions. 
The index for the new edition does not have to be completely recreated. Index-Manager’s .idx work 
files serve as backup of indexing information.

You can create .idx work files via the function Export > create fresh work file. 

With .idx work files, it is also possible for teams to work on projects. The usertoken function  provides 
team members’ work files an additional attached name abbreviation. All the work files for all team 
members can be imported together with the source file, revised, and exported together.

2.	Starting in Index-Manager
The welcome dialog opens automatically when you start the program. You then select a start mode, 
and compile and load the files and projects you want to work on.
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2.1	 Mode 

Each mode has a different arrangement of windows for optimal access to different indexing tasks:

•	 Text mode allows indexing along the text. The user interface contains the text window with 
the indexing toolbar, the structure window, the index list, and the index preview. You can select 
words from the text by double-clicking, or you can enter terms manually as headings or sub-
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headings in the indexing toolbar, define page number format and page ranges, define cross-re-
ferences, and you can allocate index entries to text areas. 

•	 Word List mode presents the text of the imported document in the form of single words and 
terms, along with the frequency in which they are used. Diverse filtering options and lists of 
word combinations also help to create a high-quality index. Indexable keyword combinations 
can be identified here, and you can test the index for thoroughness.

•	 Edit mode is an ideal interface for correcting and editing index entries. Index-Manager uses an 
intelligent algorithm to find different spellings and forms of terms, and recognizes terms in 
plural form, misspelled words, words with hyphens, and words written with or without capital 
letters. A few simple clicks can standardize terms in multiple imported documents, assign in-
dex entries to different entry levels, create cross-references, and much more.

•	 Index mode provides a preview of the complete index. You can view the index with or without 
subentries and cross-references. Mistakes can be corrected directly in the index preview.

Select a start mode according to the step you want to execute. For the first step in Index-Manager, we 
recommend default Text mode. 

!! Note: Mode and user-interface can be changed at any time.

2.2	 Selecting files and projects 
When you open Index-Manager for the first time, click on  in the Files window to 
open a pop-up window/explorer and select the manuscript documents you wish to work on. This file 
selection forms a “project” which will be displayed in the project list the next time you open the pro-
gram. Project file names are followed by a bracketed number of files in the project.

When you reopen Index-Manager, the file selection of the project you last worked on appears by de-
fault. Start this project to reload the document files together with their corresponding work files.

Change the file selection for a project and add or remove files with the  or  button. It will be dis-
played as new “project” with new bracketed number of files. 

To create a new project, remove the displayed selection in the Files window by using the  button or 
by clicking on the file paths and then the  button. You will then be prompted to load new manuscript 
files via . 

!! Note: Removing displayed files from the Files window does not delete the files, it just removes them 
from the current view. 
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2.3	 Import and import progress

Click the Start button to import the displayed files. A progress bar in the Progress window will show the 
progress of the manuscript import. Error or warning messages will indicate any difficulties that may 
have occurred during the import. These messages can be viewed in a log file.

The log file is automatically created when errors occur and is stored in the same folder as the loaded 
manuscripts. The error messages are often helpful for support requests and should be sent accordingly.

2.4	 User interface
Each manuscript requires its own workflow for efficient indexing. The Index-Manager program interfa-
ce is therefore very flexible. Functions can be selected and deselected via Window (Window > Change 
layout checked). Window composition and size can be set as required and windows can be distributed 
across several screens. 

To move or resize a window, click the green upper bar of its window . Clicking the green upper bar 
will detach the window and allow you to drag it with the mouse to another screen or to insert it in 
another position on the same screen (as soon as the background appears blue).

Your customized user interface is saved project-by-project and is retained even after closing and re-
opening Index-Manager.
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2.5	 Help
Press [F1] to open context help. Press [F1] again to close the context help window. Use the forward 
and back buttons to navigate between visited help entries. Click the  or  button, [Ctrl]+[F1] or 
[CMD]+[F1] (MacOS) to activate and deactivate the mouse-over function. Hover the mouse over pro-
gram elements when the help window is open and the respective help texts will be displayed.

3.	 Indexing in Text Mode
In Text Mode, the user interface contains several green windows  including a central window dis-
playing the source text view and the index toolbar, the index list window, the index preview window, 
and the structure window. 

The central text window displays the first loaded document. To see additional imported files, click on 
the corresponding document heading in the structure window. You can then click on tabs in the text 
window to access desired documents.

New index entries with multiple levels can be created with a few simple clicks. Text Mode also allows 
page ranges to be assigned, multiple indexes to be created, index-entries to be relocated, and locator 
formats and cross-references to be managed and edited.

3.1	 Creating headings and subheadings
The index toolbar is included at the top of the Text window. 

The Index toolbar contains three text input fields: for the main heading, subheading, and sub-sub-
heading. Input text into one of the fields by selecting one or more words in the text, clicking on a text 
passage and mousing-over, or by free input into the field.

Create an index entry by clicking the button .

The created index entry is displayed highlighted in green in the text, in the index list window, and in 
the index preview.
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For subheadings, select the appropriate field of entry by mouse clicks or keyboard shortcuts. 

!! Note: Existing keyboard shortcuts are displayed when you hover the cursor over a button.

As soon as you start entering text in the input field of the heading, a dropdown list of text options 
from already existing index entries will appear. These can be transferred directly to the input fields 
(auto-completion). For entries that consist of more than one level, separate entry levels with [|] (pipe). 
Subheadings are entered automatically into corresponding level fields during selection and can be 
edited further.

By default, three heading levels can be entered by clicking on the button ( , , ) and shortcuts 
([Alt]+[1], [Alt]+[2], etc...). Additional levels of entry are possible by entering a vertical line [|] (key com-
bination [Alt Gr]+[<]) either behind the last letter in the text field or in the Index list window in the 
column of the last subheading. 

Don’t worry about correcting entries at this point. You can efficiently correct or adjust spelling, index 
names, entry levels, and upper and lower case with Index-Manager’s edit functions both in the index 
list, in the editing window, and in the index preview.

The index toolbar has two buttons to facilitate corrections and input right away:

•	   swaps heading and subheading.

•	   toggles between upper and lower case for the selected heading. 
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3.2	 Anchor position
To create an index entry, you have to define an anchor position in the text. Default anchors are located 
at the last text passage selected by double-click. If an index entry is entered freely without first clicking 
on a text passage, set its anchor by clicking  and then selecting a text passage. Then click  
to create the full index entry. 

!! Note: The create entry button remains grayed out and is disabled as long as no anchor is defined.

To move an anchor to a different position in the text, for example, when the index entry is in a heading 
but should not be or vice versa, or when the text of an index entry is in a table or illustration but the 
anchor should be in the legend or header line:

•	 Select entry level 1 via the  or use the key combination [Alt]+[1].

•	 Select the term(s) you want to index or enter the text into the toolbar.

•	 Click  or use the [Alt]+[A] key combination and then select the term(s) that is to serve as the 
anchor position.

To change the anchor position for an existing index entry, right click the index entry in the index list 
or double-click the index entry in full text view and then edit via the toolbar functions. Instead of 

, you will see . Click  to save the edited entry.

!! Note: The index toolbar and  button is the only way to change the anchor position for an index entry. 

3.3	 Several indexes
When you enter a main heading (with or without subheadings), you can select which index it should 
go into from a dropdown list. To add a new index: type the new index name in the input field. Click 

 to add the index entry to the new index. The new index name will be displayed in the index 
list in the corresponding column Index name. 

You can also select index names as an additional filter option in the index list filter bar.

3.4	 Page ranges
Continuous discussion of a topic that traverses two or more sections or pages is typically indicated by 
a page range. Depending on the format of the imported source document, Index-Manager offers diffe-
rent ways to indicate page ranges. 

If the imported file is a Word file, enter the main heading (with or without subheadings) and press . 
Select the starting point for the page range by double-clicking on the corresponding text passage. This 
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will activate . Select the end point for the range, and press . The page range column in 
the index list will then note the range. 

InDesign has more options for indicating page ranges, including page or section numbers. If the impor-
ted file is an InDesign document, Index-Manager will offer you a dropdown menu with these possibili-
ties. In point of fact, however, Index-Manager has no information about the formats used in InDesign. 
The best way to indicate a page-range for an InDesign index is to count and insert the number of 
paragraphs in the corresponding input field. (In the text view, every InDesign paragraph starts with 
an enlarged letter.) We recommend you compare the InDesign document with the displayed format 
information. You may want to use other page range options.

3.5	 Locator italic or bold
Page number locators marked in bold or italic often indicate special items on a page, such as illustra-
tions or tables. To define the page number format for such an entry, enter the main heading (with or 
without subheadings) and click  for bold or  for italic. You will then see the corresponding infor-
mation in the index list column PageNumberFormat.

!! Note: InDesign has more options for formatting locators. If the imported file is an InDesign document, 
Index-Manager will offer you a dropdown menu with these possibilities.

3.6	 Toolbar Extras
Click  in the upper right corner of the left window to access more functions:

•	 Clear levels after creating entries – uncheck this option to keep the heading and subheading.
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•	 Auto complete clears other levels – uncheck this option to keep inserted subheadings.

•	 Adopt to previous anchor places entries directly after the last listed index entry. This is useful 
for tables, for example, when many entries may need to be set in the table legend. 

4.	Search in text 
In Text mode, the text view is in center stage, and indexing is done sequentially through the text. The 
following searches can help find individual terms in the text, and help you include them in the index 
(with appropriate subheadings as necessary). 

4.1	 [Ctrl]+[F] search
The key combination [Ctrl]+[F] (or Mac: [Cmd]+[F]) opens the search function at the bottom of the text 
window. You can enter any search terms in the search field. Use the  buttons to select the search 
direction. Click  to highlight all instances of the search terms in the active document. 

To run the same search term over several chapters and loaded documents use the  buttons, and 
activate the display of the next text section via the structure window and clicking on the correspon-
ding activated chapter or document headings. 

This function only searches exact search terms or strings. If you want to search similar words and their 
inflected forms or if you have loaded more than one document and want to search the entire project, 
use the Word List window with its extended search functions (Window > Word List) or use the search 
function in the Context window. 

4.2	 Context window
Go to menu Window > Context to open the context window. Enter a search word or phrase into the 
input field in the toolbar by clicking on it in the text. The context window will then automatically show 
all text snippets with the highlighted search word or phrase in order of its appearance and with section 
number and existing headings. Scroll through the word contexts, and you can quickly decide whether 
additional subheadings need to be created. Enter the subheadings manually. Clicking on a word or 
phrase in the text will initiate a new search.

!! Note: The number of words displayed as snippets can be changed under Menu Extras > Preferences > 
Context: Number of words. The default number of words displayed is 40 words before the search word 
or phrase and 40 words after.
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5.	Cross references 
Cross-references can be entered directly into the Text window toolbar input field with [=] after the 
entry. For example, “bioindicators=biological indicators” will create the entry, “biological indicators, see 
bioindicators”. Add further terms with additional [=] to create multiple cross-references (e.g. “bioindi-
cators=biological indicators=Bis”). 

Cross-references can also be created and managed via the Cross-References window. Insert new links 
in the input fields in any form used in your source program: see, see also, s.a., etc. Use the pipe [|] to 
insert links with any subheadings.
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Extra: Use the drop-down menu (which can be opened by clicking ) for double-posting cross-refe-
rences, to define and switch the main/target entry for individual selected cross-references, or to move 
existing entries to the main/target entry. In contrast to see also references, no page references should 
appear in the reference entries for see references. 

Cross-reference entries will appear in red when they do not have matching target entries. These 
cross-references will be lost after export and reopened in Index-Manager. 

!! Note: Check the cross-reference window before closing the program.

!! Note: To create general cross-references (e.g. see also specific drugs), add their text directly into the main 
heading. (For example, set the main heading for “drugs” as “drugs, see also specific drugs”.)

6.	Editing index entries
Index entries can be edited at any time in the index list or in the index preview.
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6.1	 Index window
The Index window displays all existing index entries in a tabular view. Different columns show diffe-
rent information for each entry. Define displayed columns with a right mouse click and the context 
menu. Change the order of columns by drag & drop. Change the table view and sort order of entries by 
clicking in the table header of a column. 

Ways to edit: 

•	 Single table cells: double-click and then manually make changes in a cell.

•	 Single entries: select an entry’s whole line and then make changes.

•	 Multiple entries: click [Ctrl] + Select to select more than one entry, and then right-click to open 
the context window and additional functions, such as Edit.

•	 Multiple entries: use the search window and then click [Ctrl]+[A] to select all of the results or 
[Ctrl] + Select for a subset of, and then right-click for the context menu and additional func-
tions. 

When you right click a selected entry or entries, the following options will be available for editing:

•	 Update entry automatically transfers an entry to the input fields of the text window toolbar 
where you can then edit headings and the locator format or change the anchor position. Click 

 to save the edited entry.

•	 Copy selected entries to the editing window for further editing in the Edit window.

•	 Duplicate to create inversions or make other changes in entries, e.g. International Cooperation 
 Cooperation, International

•	 Index Actions, such as italicizing an entry, or merging or swapping heading levels. 

6.2	 Search entries in index list
Filter options allow advanced searches. First, specify whether an advanced search should be perfor-
med with regular expressions (rx) or case sensitive (cs), or both. Then choose which column the search 
should be run in: click the small triangle and select the column name. The corresponding column hea-
ding will be italicized in the table.

The regular expression “^[A-Z]” combined with searching the selected column will display all headings 
starting with initial caps. “^[a-z]” will display all headings beginning with lowercase. Select all the re-
sults with [Ctrl]+[A], and then you can apply an index-action to all those entries. 

6.3	 Deleting entries
In the Index list, select the full lines of the index entries you wish to delete, then press the [Del] key or 
[Function]+[Backspace] (MacOS).

!! Note: This is the only way to delete index entries in Index-Manager! Make sure that the whole line is 
selected and not just a single table cell.

6.4	 Index actions editor
The Index actions editor is available under Extras > Index Actions. This is where you can create your own 
frequently used actions to speed up your work. 
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When you first open the Index actions editor, the list will be empty. Click  to see frequently 
used actions. Click  to save.

To create a new index action, define the name, its shortcut, its action, and the column to which the acti-
on is to refer. Specify whether an advanced search should be performed with regular expressions (rx) or 
case sensitive (cs). Click  to transfer the action to the list of Index actions, then click  
to save. A new index action to italicize subentries corresponds to the action for italicizing main entries, 
except in the selection of the column to which the action is to be applied. Here subentry must be dis-
played in the new action line.

Default and other sample Index actions:

Name Search Replace Column Options Shortcut
.docx bold

Oak -> <b>Oak</b>

(.+) <b>\1</b> Entry rx Alt+B

.docx italic

Oak -> <i>Oak</i>

(.+) <i>\1</i> Entry rx Alt+I

.idml bold (.+) !!\1!!!;\1 Entry rx Ctrl+Alt+B

.idml italic (.+) ##\1###;\1 Entry rx Ctrl+Alt+I
Index name Names index Index name Alt+N
Index place Places index Index name Alt+P
Initial Caps

Oak -> Oak

^(.)(.*) \U(\1\U)\2 C o m p l e t e 
entry

rxcs Ctrl+Alt+C

Initial Lows

Oak -> oak

^(.)(.*) \L(\1\L)\2 C o m p l e t e 
entry

rxcs Ctrl+Alt+L

Merge levels

A m e r i c a n | O a k 
-> American, Oak

([^\|]*)\|(.*) \1, \2 C o m p l e t e 
entry

rx Ctrl+Alt+M

Swap level 
O a k | A m e r i c a n  
-> American|Oak

([^\|]*)\|(.*) \2|\1 C o m l e t e 
entry

rx Ctrl+Alt+S

Swap name 
John Miller -> Miller, 
John

(.*) (.*) \2, \1 Entry rx Ctrl+Alt+N

Swap parenthesis 
UN (United Nation) 
-> United Nation 
(UN)

(.*) \((.*)\) \2 (\1) Entry rx Ctrl+Alt+T

Forced sorting (.+) \1;\1 Entry rx

6.5	 Bold and italic headings or subheadings
While the HTML tags for bold <b>Oak</b> and italic <i>Oak</i> are correctly converted in Microsoft 
Word when the final index is generated, in InDesign, you will need to make some special formatting 
edits. These can be done globally. 
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!! Note: You will have to make these edits every time the index is regenerated.

To make these edits globally in InDesign, first, make sure that search-and-replace works for italics in 
your version of InDesign. 

Next, review how your index entries to be formatted in italics are marked. For example, the text to be 
italicized in your index may be marked with preceding and following ##. 

In InDesign, to change the text between the ** or ## marks to italics, put an insertion point at the be-
ginning of the index story and bring up the Find/Change dialog box.

You can see in the screenshot below exactly how to set up your search and replace: 

•	 Select the GREP tab.

•	 In the Find what: box, type in what you need to search for, such as “##(.+)###” (replace the ## 
marks with whatever else you are using as markup around the text to be italicized).

•	 In the Change to: box, type in the code for the replacement text, such as “$1”, as shown below.

•	 In the Change Format box, select Italic, and then click “OK” to get back to this dialog window. 
Make sure the Find/Change window looks like the screenshot image below.

•	 Click „Change All“.

After doing such a replacement, it’s a good idea to do a simple text search for “#” and see if there are 
any lurking. Switch back to the Text tab of the Find/Change dialog box for this search.
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6.6	 Editing Window
To edit index entries quickly and, if necessary, in groups, open the Edit window. Here you can unify 
entries, duplicate entries, swap levels, and divide multi-part terms into several levels, all with just a few 
clicks. The dropdown menu to all Index actions is also available.

To transfer index entries to the editing window, select entries from the index list (via the search window 
or by [Ctrl] + Select, for example), and then click “Edit entries” with the right mouse button or drag & 
drop the selected entries into the editing window.

The Edit window consists of two tables in which the selected index entries are displayed. Use the small 
arrow on the right to determine column selection and the columns in which changes will be made and/
or select single rows. Use search and replace to adjust and standardize spelling across all levels. You can 
also use advanced search and replace with regular expressions (rx) and uppercase (cs).

The two tables initially have the same contents. The table on the left displays the original selected 
index entries. The table on the right displays how entries will look after editing. Changes are displayed 
immediately after input in the search and replace field. For complex search and replace with regular 
expressions, you will be able to review the results of the replacement before you finalize editing. Click 
the Set button to finalize editing.

The following index actions are carried out directly upon clicking without preview:

 to swap and change entry levels.

 an entry after an empty space, a comma or another delimiter on two levels. 

 selected entries.

Additional functions can also be performed in selected rows or columns. 

7.	 Indexing in the Word List mode 

Open Word List mode via Mode > Word list in the opening Welcome window, via the menu item Mode 
> Word list, or via Window > Word list.

The filterable Word List offers various options and windows to facilitate selecting index terms and for 
systematic indexing.

The Word List displays all the words contained in the loaded files. The table columns offer different pos-
sibilities for sorting (number, alphabet, index entries, position, length). Change the sorting by clicking 
on the respective column header. 

Index-Manager contains stop word lists for German and English, including words that occur very fre-
quently and that are usually not relevant for an index. These stop words include articles, conjunctions, 
and prepositions. Uncheck Stop word in the list of all Exclude… filter options in case you need to include 
these words. 

!! Note: Contact us if you want to use Index-Manager for other languages or to create your own stop word 
list.

Click on a line in the Word List table to make the word or phrase the main heading in the first level of 
the index toolbar in the text window. Edit the text of the heading in the text window toolbar, and add 
any subheading. The full text view will jump to the position where the term is first mentioned in the 
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text. All occurrences of the word or phrase in the loaded documents are listed in tabular form in the 
section panel.

7.1	 Index term extraction via the Word List filter
The Word List filters allow additional fine-tuning of the display.

Use reducing to to display:

•	 words in special formats such as bold or italic, 

•	 words highlighted by authors or publishers, 

•	 words of headings. In a well-structured document, all headings can be systematically filtered 
and indexed one after the other, 

•	 words Always starting with capital letters to efficiently generate name and place indexes. 

•	 Phrases to detect and quickly index compound nouns.

Use Exclude to remove words from the Word List. This is useful for text areas which do not warrant 
indexing. In some projects, for example, footnotes will not be indexed. 

Use the search field to search for special characters and strings, including regular expressions and ca-
se-sensitive search.

7.2	 Find every occurrence
The Section panel gives a quick overview of all occurrences of a selected term including its various 
inflections. Click on a line in the section list, and the text view will jump to where that term is listed in 
the text. Automatically create index entries for all occurrences of a term in the text by clicking [F6] (or 
Word list  > Create all), or go through the list line by line and 

•	 Add a subheading or 

•	 Select individual lines via [Ctrl] + Select and then click [F7] or right-mouse click over the selecti-
on and click Create entries [F7]. 

The list of associated index entries shows existing index entries for a selected term.

The list of similar words shows where a selected term is also mentioned in the text, such as in com-
pound phrases. This list lets you see if you have entered all occurrences for a term. Click on a line to 
insert that word or phrase into the first tab of the index toolbar.

The list of adjoining words displays common terms from the context of a word in the word list. This list 
helps determine synonyms and additional names for people. This list also suggests subentries. Click on 
a line of the subject list to insert the term into the subheading input field of the index toolbar.

!! Note: The list of adjoining words facilitates extracting candidates for subentries. In Text mode, the con-
text window fulfills this task.

7.3	 Streamline production of name or place indexes
Extract names and places semi-automatically via the Word List. 

The word list filter Always starting with capital letter reduces the word list for English texts to all pro-
per names. Words that appear in capital letters because they are at the beginning of a sentence but are 
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otherwise lower case in text are not displayed in this filtered list. 

To index each occurrence of a name, define the final entry or edit it later and click [F6]. Note that this 
generates entries uniformly from every occurrence in every loaded file.

If, for example, it is not clear whether it’s Jack or Peter Mueller, McGraham senior or junior, or Charles 
I or II who is mentioned in the text, use Section panel and check individual occurrences before clicking 
[F6] or [F7] to create the entries. 

7.4	 Filter Files in the Word List
Filter files in the word list offers various options for indexing:

•	 Exclude terms from the word list that are not to be indexed.

•	 Reduce the word list to terms that should be indexed in any case. Such filter files can, for ex-
ample, contain names or important terms which were specified by the author or publisher and 
which must be completely indexed, such as for name or place indexes. 

There are two different filter file types: Word Filter and Term Filter files. With Word Filter files, listed 
terms are decomposed and the word list is filtered for all words occurring in the filter file separated by 
comma, space, and hyphen. The Term Filter file is suitable for indexing compound or multi-word terms, 
including first and last names. For Term Filter files, only the line break is relevant and the word list is 
filtered by the complete term or terms of a line.

Prepare the Filter file as a text file (.txt). Terms should be separated by line breaks. Use UTF (Unicode 
Transformation Format), not ANSI, to display special characters. In most cases, it is sufficient to specify 
uninflected basic forms. In cases of strong flexion, e.g. with umlauts, it is advisable to also list the inflec-
ted form. In contrast to a concordance file in Microsoft Word, not all forms of a word need to be listed, 
and no additional columns for index entries to be created have to be supplied in the Filter file. (These 
index entries will be created later in the program.)

Load the Filter file. Click  to the right of the search field of the word list and specify the filtered and 
total number of words. Click on “Load Word Filter File” or “Load Term Filter File...” to open a file dialog 
and select the desired file. The loaded file will appear as an additional filter option in the Reduce to or 
exclude list.

If you do not want the Filter file to be displayed in the word list, set this in the filter for the word list. 
Scroll down the Exclude box to the “Filter Files” entry. Click on the arrow to open the loaded Filter files. 
Check the desired file to exclude all contents of the file from your word list. These terms will be deleted 
from the displayed word list.

You can also reduce your word list via filtering to the words or terms of the loaded filter file. Scroll to 
the end of the “Reduce to” field to the “Filter Files” entry. Click on the arrow to open the loaded Filter 
files. Check the desired file to reduce your word list to the contents of the Filter file.

The word list offers various options and windows for indexing with a Filter file. 

The word list shows all occurrences of Filter file words and terms. Click on a line to use the complete 
word or term in the first tab of the index toolbar of the text window, and the full text view will jump to 
where that term first appears in the text. You can then edit the text of the heading and any subheading 
in the toolbar. To create several entries at once, use [F6] or [F7], and specify the entry to be created.
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8.	Index Preview
The Index Preview window displays the final index in alphabetical order. You can specify the number of 
columns to be displayed in the tab window. 

Every entry consists of at least a main heading and a corresponding index number (Idx-No) or cross-re-
ference. An entry may have several subheadings or sub-subheadings and several numbers. An entry 
with all its headings and subheadings and numbers is called the index record and should be distingu-
ished from a single index entry listing in the index list. 

!! Note: The numbers displayed with index entries do NOT correspond to page numbers or locators. The 
numbers displayed with index entries are numbers created by Index-Manager when creating or impor-
ting the index entries. 

Click on a letter in the letter bar to navigate to that alphabetic part of the index. 

Save the index preview as a text file by clicking  on the right-hand side of the window.

8.1	 Correct directly in the Index preview
The Index Preview is a good place to correct spelling and order of display. Double-click on a heading or 
subheading to edit or correct its spelling. Corrections and changes made here are carried out automati-
cally at all associated occurrences. 

Headings that differ slightly and which are displayed as separate entries will be merged together im-
mediately upon rectification. For example, the headings “aerosol” and “aerosols” will merge immedia-
tely once they are both spelled the same way.

8.2	 Forced sorting in the Index preview
Digits or special characters at the beginning of an entry force the entry to be displayed before the letter 
A at the beginning of the Index Preview. To force a different sorting, add a semicolon at the end of the 
term followed immediately and without spaces by the correct sorting for the entry. “alpha-Ketogluta-
rate;Ketoglutarate” will thus appear in the K section of entries while “alpha-Ketoglutarate” will appear 
in the A section. 

It is a good idea to make this type of change in the Index Preview, where the change only has to be 
made once, and can then be checked immediately.

These types of correction can also be done in the index list, manually or with index actions, which can 
save you some typing.

!! Note: Forced sorting with semicolon coding works at every entry level and is implemented correctly in 
both Word and InDesign.

9.	Index Density
Open the Structure window to review index density. One column of the Structure window displays the 
index ratio (number of entries: number of words x 100). Check the ratiox100 column to review the dis-
tribution and density of entries in each chapter and subchapter across the entire project. 

Assume you estimate about 400 word per page and want about 4 index entries per page. Any rate 
about 1.0 suggests you may have over indexed, whereas anything less than 1.0 and with a green back-
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ground color suggests you might have under indexed and may want to take another look. 

The ratio column is also good to use when chapters arrive separately and you need to ensure you have 
indexed all of them.

Use the Word List window to check index density at an individual word level. Change the sort order of 
the Word List table by number and you can check if frequently used words are indexed.

10.	 Export:
Click on menu item File > Export to open the Export dialog window. 

To export the index for some or all of your imported files select the appropriate files in the table. By 
default, all files are checked. Clear the selection to select files manually. 

Beside the imported file names, the Export dialog table lists the number of (already) imported entries, 
the number of newly edited and created entries, the date of the last changes, and the file size.

Check further options:

•	 Attach index: automatically attaches the Word index field at the end of your document, allo-
wing for easy review (for MS Word source documents).

•	 Create fresh work file: creates an updated version of the work file. The new work file then will 
only describe the current project state without interim or editing steps

•	 XML intend: prevents the automatic line infeed (for XML source documents).

•	 Index name as first level: is a work around for InDesign, which doesn’t support multiple inde-
xes. Select this function to have Index-Manager write index names as main headings, thus au-
tomatically sorting by index name.
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Click , and wait for the export to complete (not long).

If a red line appears, make sure your source document is closed. Index-Manager cannot use and save 
source documents unless they are closed.

When the export is completed, close Index-Manager. 

10.1	 Your Index in MS word
Index-Manager embeds your index entries into MS Word index fields without changing layout. Final 
construction of the index is fulfilled via Word functions.

To construct or display the index in your Word document, open the document in MS Word and click the 
show/hide button to see hidden formatting. You will now see your inserted index entries, including 
main headings, subheadings, page ranges, and names. At the end of the document, you will also see 
the attached MS Word Index field. 

“Index:

[Please update this field]”

!! Note: Click in the bracketed field and then right mouse click to update and place the Index.

10.2	 Your index in InDesign
Index-Manager embeds your entries into InDesign index fields without changing layout. Incompati-
bilities between different versions of InDesign can lead to layout changes, however. To avoid those 
problems, make a copy of your .idml files before you check the index. 

To see your index in InDesign, open the idml file in InDesign, and use normal InDesign functions to 
generate and place the index at the end of the document. Select the Index dialog under Menu item 
windows > fonts and tables > Index. In the Index dialog, select the button generate index, and then place 
the Index in the appropriate position in the document.
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10.3	 Archive files
During Export, Index-Manager automatically creates a subfolder called “.Index-Manager-Archive” con-
taining all files (source documents and work files) in original versions as backup copies. 

If you don’t see the archive folder: 

•	 Windows: In the Explorer dropdown menu, select Organize > Folder and search options > View 
tab > hidden files and folders > select > Show hidden files, folders and drives 

•	 MacOS: [shift] + [command] + [dot]

10.4	 Continue indexing
Documents with the newest exported index remain in the parent folder and are displayed the next 
time Index-Manager is reopened. Click Start and review the Index list status column. Your previous in-
dex entries in the Index list will now have the status “embedded” . The next new entry you add will 
have the status logged . Editing an embedded entry will produce the status logged embedded .

After a new import, the parent folder will include new empty work files, as well as your document files. 

11.	Highly flexible integration in publishing workflows
Indexing can be done in parallel to editing and layout work. Start indexing early on a draft and you will 
be able to integrate your index entries at any later time in the publication process. With Index-Manager 
work files and add-ons, indexing can be flexibly integrated into existing publishing workflows as index 
entries can be embedded at any time.

•	 Start indexing with an early version of your MS Word or InDesign document and embed index 
entries later into a modified version of the document. The indexer can embed into the final 
manuscript or they can send the index work files to the publisher for them to embed. 

•	 Start indexing with an MS Word document and embed the index entries later into another file 
format, such as InDesign or XML. The indexer can embed the entries into the final manuscript 
or they can send the index work files to the publisher for them to embed via Index-Manager.
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11.1	 XML First and automatic production workflows
Indexing can also be done directly into XML documents (after adapting the DTD). XML or XHTML tags 
can be customized to publishers` requirements for easy embedding.

The CLI (Command Line Interface) version of Index-Manager is used for integration into fully automatic 
production workflows. The CLI version takes a publication document in XML/XHTML and embeds the 
entries. If the publication is paginated in XML/XHTML, it can automatically build the back-of-the book 
index.

12.	 Replace source documents 
While indexing with Index-Manager, the manuscript can be edited and re-formatted simultaneously. 
You can always replace source documents with a more recent version.

To replace source documents with updated versions, first import your source documents with the com-
plete exported index: go to the Export Selection dialog box, check “Create fresh work files”, and then 
click . 

You have now created an updated version of your work file. This new work file describes the current 
state of the project. You can find the fresh work files in the parent folder.

Move the new work files to the folder with the most recent version of the source documents. Rename 
the files if necessary. It is important that the new source documents and the corresponding new work 
files have the same prefixes.

Open Index-Manager and import the new source documents as a new project. Index-Manager will 
automatically import the work files with the source documents.

Regarding the status of index entries in the index window in Index-Manager, note that ESW stands 
for Entry, Section, and Word anchor. Color coding denotes any errors which may have taken place and 
signals which entries should be checked for correct anchor placement. 

!! Note: Status with color coding is not available after export or closing Index-Manager.
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Object Color Meaning
E 
(Entry)

Green matching entry found
Red no matching entry found

S 
(Section)

Green section found
Red section not found

W Top 
(Word anchor Top)

Green both anchor words found
Orange one anchor word not found
red neither anchor word found

W Bottom 
(Word anchor Bot-
tom)

Green word position unchanged
Orange word position in relation to beginning 

of section changed by up to 10 words
Red word position in relation to beginning 

of section changed by more than 10 
words

Normal export function embeds checked index entries into the current source files.

13.	 Add-on: Index-Import
The Index Import add-on facilitates precise embedding of index entries from a separate index into 
Word, InDesign, or XML documents. This allows existing indexes to be used for subsequent editions or 
for digital products and hyperlinked index entries. 

The Index Import add-on uses a heuristic approach to determine the likely best position for each entry.

The user decides to what extent the embedding should be automated or manually controlled. Main 
and subheading format as well as page number formats will be automatically adopted from the exis-
ting index. Page ranges and cross-references will be displayed, but not automatically transferred. (They 
can be added easily via Index-Manager functions depending on the format of the target document.)

Before importing an index into Index-Manager, the index must be in a specific format and saved as a 
.txt file. 

13.1	 Index conversion
Convert the existing index to the following format: 

Abrahamian, E. J. <idx>264</idx>

<i>Abstinence Self-Efficacy scale</i> <idx>289</idx>

Abstract facet pole <idx>19</idx> <idx>73</idx> <idx>See also Concrete–Abstract facet scale</idx>

academic achievement and grades <idx>See also college and university students; educational set-
tings</idx>

– importance of <idx>268–269</idx>

– intervention/outcome studies <idx format=’\b’>229</idx>, <idx>285–287</idx>

– Judging type and <idx>237</idx>

– retention rates and <idx format=’\i’>236</idx>
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– – roommate studies and <idx>238</idx>

– type and <idx>214</idx> <idx>236–237</idx>

– writing skills and <idx>235–236</idx>

Accepting facet pole <idx>20</idx> <idx>78</idx> <idx>113</idx> <idx>See also Critical–Accepting fa-
cet scale</idx>

Accommodating facet pole <idx>20</idx> <idx>77–78</idx> <idx>113</idx> <idx>See also Questio-
ning–Accommodating facet scale</idx>

<b>accountants</b> <idx>84–86</idx> <idx>212</idx>

attitudes <idx>See orientation pairs</idx>

!! Note the <idx> and </idx> codes around locators and cross-references, as well as the endashes and spa-
ces at the start of subheadings, and the various special italic and boldface codes. All of these need to be 
included in the imported index.

Layout and format of source indexes differ depending on which indexing programs were used to create 
them or which source they came from. The following describes the most frequent conversion steps. 
Regular expressions and search/replace instructions may need to be adjusted slightly.

For more assistance with conversion, please contact us or use Barry Campbell’s IndexConvert: 

http://www.indexbase.co.uk/

http://www.indexbase.co.uk/IndexConvert.html

or follow the import manual, as above.

Watch out for special cases:

•	 f./ff.

•	 cross-references

•	 special formats and signs

•	 page ranges

•	 subentries (up to which level) 

!! Note: Paragraph and character formats such as italics and boldface are not included in text editors. To 
preserve this information, use appropriate tags. You can add these in Microsoft Word via Search and 
Replace.

13.1.1	 Preparation of character formats in Word 

Italic/bold format in locators and entries should be replaced with special tags as follows (S: stands for 
Search and R: stands for Replace with):

13.1.1.1	 Cross-reference formats

… which are determined by the program in which the final index was constructed, may have to be de-
leted instead of replaced with special tags. 

S: See also font italic 

http://www.indexbase.co.uk/
http://www.indexbase.co.uk/
http://www.indexbase.co.uk/IndexConvert.html
http://www.indexbase.co.uk/IndexConvert.html
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R: See also font normal 
 See also  See also 
S: See font italic 
R: See font normal

13.1.1.2	 Locator font

S: [0-9]{1;3} font italic or bold and pattern/wildcard 
R: <idx format=i>^&</idx> or <idx format=b>^&</idx> font normal  
36, 34  <idx format=i>36</idx>, 34 or 36, 34  <idx format=b>36</idx>, 34 
Replace <idx format=i> or <idx format=b> in a second step: 
S: <idx format=i> or <idx format=b> 
R: <idx format=‘\i‘> or <idx format=‘\b‘> 
 36, 34  <idx format=‘\i‘>36</idx>, 34 or <idx format=‘\b‘>36</idx>, 34

13.1.1.3	 Headings and subheadings

S: by format: font italic or bold  
R: <i>^&</i> or <b>^&</b> 
 heart infarct  <i>heart infarct</i> or heart infarct  <b>heart infarct</b>

13.1.2	 Conversion in Text editor 

If your text editor does not use perl syntax you will need other regular expressions.

MacOs Text editors: https://www.cleverfiles.com/howto/top-5-text-editors-mac.html

Windows Text editor Notepad++: https://notepad-plus-plus.org/download/v7.6.4.html

1.	 copy text to Notepad++ 
Encoding > Convert to UTF-8

2.	 Delete ABC Headers if you have not already done so 
S: ^[A-Z]\r\n 
R: ((empty)) 
and/or remove blank lines 
S: \r\n\r\n 
R: \r\n

3.	 replace page numbers with <Index page number> 
S: (\s+)([0-9f\.\-–\s]+)(,|\r\n) or (\s+)([0-9f\.\-–\s]+)(,|\r\n|  See) 
R: $1<idx>$2</idx>$3 
Explanation: (empty/white space)(digits+f+dots+empty/white space+tabs)(, or Crlf carriage 
return line feed) 
example: 264 -> <idx>264</idx> 
or with Roman locators (example: Brain infarct	 302–303, 304, i, ii, iii, v, x xxx, xxxix, v): 
S: (\s+)([0-9f#ivx\.\-–\s]+)(,|\r\n)

https://www.cleverfiles.com/howto/top-5-text-editors-mac.html
https://notepad-plus-plus.org/download/v7.6.4.html
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4.	 remove other commas between the page numbers 
S: idx>, 
R: idx>

5.	 convert sublevel paints to correct character and blank, if applicable (-) 
S: ^–– 
R: - - and in a second step 
S: ^– 
R: - 

6.	 (convert ff./f.-as locators into italic and bold formats if necessary, – rheumatoid Arthritis 214ff)  
S: <idx>([^f]+)ff\.?</idx> 
R: <idx format=‘\\i‘>$1</idx> 
S: <idx>([^f]+)f\.?</idx> 
R: <idx format=‘\\b‘>$1</idx>

7.	 (delete double blank See)  
S:   See 
R:  See

8.	 (convert cross-references)  
S: (See.*)\r\n 
R: <idx>$1</idx>\r\n 
 attitudes See orientation pairs  attitudes <idx>See orientation pairs</idx>

13.2	 Index-import step by step
Make sure that your Index-Manager license includes the Index-import feature. You can find this infor-
mation in the Welcome window at the bottom left.

Import the target document into which the index entries are to be integrated.

Open your project. 

In the Window menu, select Index-Import.

Adjust size and position of the opening Index Import window. 

Click  to open the Explorer window and select the appropriate .txt format index file.

Click  to start loading the index file. A progress bar will indicate import progress.

The left table of the Index Import window shows the loaded index entries together with their corres-
ponding locators and the results of Index-Manager’s analysis. Adjust column order with drag & drop. 
Sort by clicking one of the column headings. 

The left table contains the following columns: 

•	 No: Number assigned when importing the index according to alphabetical order and locator.

•	 Index Entry: Complete entry with subentries separated by |

•	 Page: Locator from the index.txt file

•	 Format: Page number format

•	 Best anchor score: hit probability for the proposed anchor. The higher the score, the more likely 
the anchor is in the correct position.
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•	 Best Anchor position: section number of the best anchor position

•	 Number of anchors: total number of existing anchor positions in the loaded document 

•	 Row: Row number in corresponding index.txt file

For a first review of the import index, we recommend you sort the imported index entries by page 
number. 

Click on an index entry to transfer it to the index toolbar in the text window. This will also make the 
text view of the document jump to the most probable anchor position. 

The right side of the index import window displays analysis results for the selected entry. 

If the anchor position for the selected imported index entry is correct, accept and insert the entry by 
double-clicking on the entry in the index-import table or via  in the index toolbar. 

In case the anchor position needs to be changed, note that  is already preselected. Select another 
anchor position by clicking on another word in the text field, or by choosing another position via the 
right table in the Index import window. 

The right table has additional information on the various anchor positions that may help you make 
your selection. The right table contains the following columns:

•	 Score close/far anchor: Boost + score (close) is 200 minus distance or score (far) is minus 100 
-- distance

•	 Distance: the distance between the position in the HTML and the position in the histogram in 
relation to the total number of pages of the document x10

•	 Position: Number of the section of the respective anchor position. 

•	 Word: the term of the index entry used to determine the anchor position.

•	 Type: Anchor (near) indicates that the assumed anchor position is within the pages to consider, 
Anchor (far) indicates that it is outside the analysis range.

•	 Tags: Paragraph and character format of the respective anchor position

•	 Surrounding text: the text surrounding the anchor position 

After creating the entry, the selection will automatically jump to the next entry, and you can proceed 
through the text and manually import each entry into the target document. 

In the Index List, check whether format specifications have been adopted for entries.

Following is the recommended procedure for automatically importing most of the entries.

Sort the list of imported index entries by the best anchor score. Check random individual index entries 
of the best, middle and worst score lines. Select entries up to the lowest still-correct score, and then 
click  to accept them. Imported index entries with scores smaller than zero should generally 
be checked and embedded manually.

Click  in the upper right corner of the left window to find more functions:

Further options are available in case the results and proposed anchor positions are unsatisfactory. The 
analysis area, usually preset to three pages, can be reduced or enlarged. 

!! Note: if the analysis area is enlarged, other processes may slow down as more extensive calculations 
will be required.
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The Format tag boosts table allows you to exclude or favor existing formats and tags in the document 
as anchor positions, e.g. headings and boldface text. Click  to add a line. Enter the appropriate 
tag and the boost value into the cells, e.g. Tag bold and Boost 100. The Boost value will be added to the 
corresponding anchor score, so that boldface positions get correspondingly better anchor scores, for 
example. Don’t forget to update the changes, even if you have deleted a format from the list using 

.

Jump to best anchor is activated by default. The text window jumps to the assumed best anchor posi-
tion. Sometimes it makes sense to deactivate this function and activate Minimal scrolling (if there are 
many footnotes in the document, for example, and you want to avoid jumping back and forth between 
the footnote display and the continuous text, or if there are many concepts in the index that have no 
direct equivalents in the text).

Next entry after creating entry is also activated by default. This option can be disabled, however, if you 
want to select the next entry manually and don’t want to jump to the next anchor position in the text 
window.

Adopt previous anchor places entries directly after the last advertised entry. This is important for tab-
les, for example, when entries need to be set in the legend and not the table itself.

The Index-Manager Index Import add-on uses a heuristic approach to position index entries in the tar-
get document. The analysis is a multi-level process. 

A multi-channel histogram is created from all entries. For each entry, all occurrences in the text are se-
arched for and entered as grid points. To search for occurrences in the text, entries are split into levels, 
into word limiters (space, comma, minus, dot) and expanded, stop words are removed, and term syntax 
is reduced (stemming).

As the loaded target document does not contain page references, Index-Manager estimates the size 
of a page based on the total size of the document and the highest locator in the index followed by 
monotonizing the page order. 

Index-Manager reviews the text in the analysis area, three pages preset, and looks where most of the 
entries of the surrounding three pages fit best. Each entry receives its best so-called Bin, taking in ac-
count the best estimated position in the histogram and the position in the HTML view.

Finally, Index-Manager collects the results of the analysis. A relative distance measure indicates the 
distance between the position in the HTML and the position in the histogram in relation to the total 
number of pages of the document x10.

If the relative distance measure is smaller than the pages to consider, the anchor is considered to be 
close and gets a boost of +200, meaning that the score is 200 minus distance.

If the relative distance is greater than the pages to consider, the anchor is considered far and gets a 
boost of –100, meaning that the score is –100 minus distance.

Some special cases are also considered in the score calculation. Format boosts added via the further 
options dialog are added to the score, for example.

14.	 Add-on: Index-Transfer
With this add-on, index entries from one document file can be transferred to another document in a 
different file format, e.g. from a Microsoft Word file to an Adobe InDesign file. This allows flexible in-
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tegration of indexing into normal production processes. Indexing can start with Word documents and 
embedding of the entries can take place in InDesign or XML files, in parallel with layout.

Files in different formats have different structures, so any position information stored in working .idx 
files is not helpful. Index-manager therefore uses structure-independent text comparison for transfer-
ring index entries from one document to another. 

Make sure that your purchased license of Index-Manager includes the Index-import feature. You can 
find this information in the Welcome window at the bottom left.

Import the target document into which the entries are to be transferred. 

Go to the menu Extras > Adopt index to open the add-on explorer. Select the indexed document cont-
aining the embedded index entries. Click  and the transfer will start automatically. A pro-
gress bar will show the progress.

The Index-Manager transfer algorithm compares 30 words before and 30 words after an entry. This 
procedure is robust. Even if there are differences in versions, or individual words are exchanged or 
deleted, index entries are positioned correctly. Any entries for which there is no text correspondence 
in the target document will be placed at the beginning of the document. Index entries for sections or 
paragraphs which are omitted from the target document, for example, will be placed at the beginning 
of the target document. The status for these “superfluous” entries will be set with a warning.

Note the status of the transferred index entries in the index window. . Color coding denotes errors 
which have taken place. If an entry has a red colored T(ransfer) or a warning signal, it signals that the 
anchor for the index entry should be checked and possibly moved or the entry eventually deleted. 

!! Note: Color-coded status is not available after export or closing Index-Manager.

Normal export function embeds checked index entries into the current document source files.

15.	 BoB or Stand-alone Index with Index-Manager
To create a Back-Of-the-Book (BoB) or stand-alone index with Index-Manager for a PDF source file, first 
convert it with OCR to MS Word. 

To control the page numbers in the MS word version of the book document, manually delete or insert 
page breaks and make sure that both documents have the same number of pages. 

Once the MS Word document pagination matches the PDF pagination, deactivate the view of any hid-
den functions, and save the document. Now you can import it into Index-Manager for indexing.

Create the index in Index-Manager and export the index to the Word document. Don’t forget to select 
the option to attach the index. After exporting the index to the Word document, update the index field 
at the end of the document, make any layout adjustments, and extract a copy of the index. 
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